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1. Introduction

Use the Control4® Composer Media Edition (Composer ME) application to set up your media and
playlists and perform other tasks related to your music, movies, and videos.

1.1 Purpose

The purpose of this document is to give you instructions, examples, and tips about how to add and
manage the media for your Control4 system. This document applies to the Control4 Operating System
2.4.0 (OS 2.4.0).

Words that appear in red are either in the Glossary or provide tips, examples, and other important
information.

1.2 Related Documents and Resources

Document Title Location

Control4 System Quick | PDF: http:/www.control4.com/residential/products/resources/
Start Guide (200-00153)

Control4 System User PDF or Help: http://www.control4.com/residential/products/resources/
Guide (200-00001)

Control4 Composer Help: Composer HE application
Home Edition Getting PDF: http://www.control4.com/residential/products/resources/
Started

(200-00169)

Control4 Composer PDF or Help: http://www.control4.com/residential/products/resources/
Home Edition User
Guide (200-00170)

Control4 System PDF only: http://www.control4.com/residential/products/resources/
Remote Control SR-
250 User Guide
(200-00152)

Control4 MyHome PDF: http://www.control4.com/residential/products/resources/
Setup Guide for
Homeowners (DOC-
00004)
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What’s New in This Release?

The Control4® Composer Media Edition (Composer ME) software and hardware updates for OS 2.4.0
and earlier are detailed below.

0SS 24.0

e Added support for Access Anywhere for mobile devices and the web. Access Anywhere is a
feature of 4Sight that lets you connect to a Control4 system from a remote location worldwide
using a variety of mobile device types, tablets, or the web. See the Access Anywhere
documentation on the Residential Documentation page.

e Added support for Tuneln, which lets users access streaming music, news, sports, podcasts,
and more worldwide using the Tuneln app from Navigators. Available on new or legacy
systems. HC-250, HC-800, and HC-1000 controllers that upgrade to OS 2.4 can benefit from
Tuneln. See the Tuneln User Guide for details on the Residential Documentation page.

e MyHome, Tuneln, and Audio/Video Intercom apps are installed automatically with an upgrade
to OS 2.4 or when you purchase a new HC-250 or HC-800 controller (for a limited time). See
the System User Guide for details about Tuneln.

Getting Started

Control4® Composer Media Edition (Composer ME) is the software you use to add, scan media, edit
media information, and create playlists in the Control4 system for use with the Control4 Navigators.
Using a Windows XP-based PC, this program uses a drag-and-drop interface and runs on the
Control4 Operating System (OS) Release 2.0 (OS 2.0) and later.

The brains of the Control4 system are the Control4 controller (for example, HC-800 controller). The
controller communicates with Control4 and third-party products to enable home automation and
interaction of Control4-controlled devices.

Notes: (1) The term 'controller' referenced in this document refers to any Control4 product that
contains the Director component, for example, HC-800 controller. Director is the software that controls
the system. (2) The new Sony STR-DA2800ES with Full Control4 Automation and Sony STR-
DAS800ES with Full Control4 Automation use Director also.

2.1 Requirements
Control4® Composer ME requires that your system is functioning correctly before attempting to use
this software (OS 2.4.0 and later). Talk to your Control4 dealer if this product does not function as
documented; this may indicate that the Control4 system may not be set up properly.
Software and network requirements for using Composer ME:
e Control4 controller (for example, HC-800 controller). Note: The Media Controller and Home
Theater Controller are not supported in OS 2.0 and later as the Primary controllers
(Secondary controllers only).
e PC to run the Composer ME software and control the devices.
e Composer ME (launches Microsoft .NET 1.1 web install).
Copyright © 2013 Control4. All Rights Reserved.
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e Microsoft Windows XP and Service Pack 3 (Home or Professional), Windows Vista, or
Windows 7 or 8.

e 500 MHz processor or higher.

e 256 MB RAM.

e 90 MB hard disk space.

¢ Video card and monitor supporting resolution of 1024 x 768 or higher.
e Keyboard.

e Mouse.

e TCP/IP-based home network (DSL/cable modem, Control4 secure gateway, router, or switch)
to connect the PC to the controller.

¢ Internet connection (broadband required for retrieving cover art and media information).

e Registration at my.control4.com is required. See your dealer or the Control4 System Quick
Start Guide for details.

Installing Composer ME

Follow the steps below to install the Control4® Composer ME software.

Prerequisites

Ensure that you understand the software and network requirements to use this product. Your dealer
or installer can assist you if needed.

To install Composer ME:

1. Start the Composer ME installation and follow the on-screen instructions. You might be asked for
a registration key. If so, check with your dealer or installer for details.

2. If prompted to update, follow the on-screen instructions to update to the latest version of
Composer ME.

The Composer ME software and device drivers may have been updated when the CD or web
download was created. Control4 recommends, however, that you always choose to update.

Starting Composer ME

When you start Composer ME, you must connect to Director on your home network.

Prerequisites

Ensure that you have installed Composer ME and registered on my.control4.com. You may want to
sign up for and use Rhapsody® also (a subscription-based music service). See the website for your
service to learn how to run the music service in the Control4 system.

To start Composer ME:
1. From the desktop, double-click the Composer ME icon.
2. Atthe Composer ME startup screen, click Director on Local Network.

Copyright © 2013 Control4. All Rights Reserved.
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Composer

Director on Local Network

(69 5ot composer COntrO|@

3. From the Directors dialog, select the Director’s address of the controller you are setting up.

|

Directors

M arne Address i Connect
Steph i i

gpeterzon-desktop 1 I B —
wirLz-test-contraller- 1 RE 0 i i

DanzDesk HCTO000-000 - e e i (B P

home-controller-1000 000w i1 |

attzandHC-1000-000 s b i ift

home-controller-1008 000w 0 il FLh

WEPHA-PROD 182 mwss i1 i = Add...
home-contraller-300 mmEss 1 i1 ({3t d

WebDewHCI00-000F = ims e 1l (E Ak = Femove
home-controller-B00 RRESS 1 il i

hn:_nlme-n::u:lntrn:-lller"-zlilplju I.III.Ir._..._ i1 |! |!: i 3

Tip: If the Director's address does not appear immediately, click the Refresh button. If it still does not

appear, contact your dealer.

4. Click Connect. Composer ME opens to the main Composer ME interface.

Copyright © 2013 Control4. All Rights Reserved.
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(=) reda
Director Status: |die () Connected

Refreshing the Navigators

Use the Control4® Composer ME menu bar to refresh your touch screens, on-screen Navigators,
MyHome apps, and System Remote Control whenever you make changes to Composer ME.

Prerequisites

Ensure that the Navigators are added and identified to the Control4 system. Your dealer or installer
can help you.

To refresh the Navigators:

In case your Navigators do not automatically refresh after you've made changes to Composer ME,
from the menu bar, choose File > Refresh Navigators.

Tip: New media shows up automatically in the Navigators unless your device is disconnected or has
changed locations. In this case, you may need to identify the device again.

Refer to the Control4 System User Guide to test your Navigator features.

Closing Composer ME

Use the Control4® Composer ME File > Exit or Exit Composer options to close the application.

Before Composer ME exits, the application asks you if you want to back up your project. It is always
good practice to do so.

Saved: 2/27/2013 10:13:00 AM
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3. Introducing Composer ME

The Control4®Composer ME interface lets you:

e Add and scan media to your controller (for example, HC-250, HC-800, or HC-1000
controllers).

e Create playlists of MP3, MP4, AAC, FLAC, or WMA files saved on your controller's hard drive
in the media database (requires a HC-1000 controller).

Prerequisites
Ensure that Composer ME has been installed.

To use Composer ME:
1. Start Composer ME.

2. Connect to the Director on Local Network. (See “Director's Dialog” section below.)
3. View the Media pane (see below).

Composer ME interface:

Composer 2.1.0

&
(o)
]

Eie Meds Help

Optians

Seanhing Schedule

) Seagate FresdgentDesktop

45, gweRDE_Intemnaional
L gweRDg_Jazz

15, gweR10_Rap

L oweRT1_Reagae
15 gweR12_Talk Rado
L TheWho

@ Media

= &, Netwark Fle Storage: © Never
£ Audio Media
I, Video Medis O Evey

© Onthe folawing days:

#EMRZMED‘AJ“MPDR“’E Sundap Mondsy | | Tuesdsp | | Wednesday
et
Media Player Thusday || Fiiday Satuday
4 Screen Saver
4 Boadcast .
4 Sirius Audio
43 Dish Netuwork
OhE ViE Files Ta Sean
A Catle T Devices: Extensions
7 Playlists [ Hetwork Fie Storage: P fAudio] ~ Add.
4z, gweR00 Favoites [ Sesgate FreshgenDeskion || P (Aude]
{Audio] Remave
2 aweRD2 Alemative [] LERAR MEDI&JUMFORIVE | | DD video)
oz, gweR03 Blues O Turer 2 150 [Video]
1L, oweRD4 Classical ] Media Plager A4l Video)
L. gweRD5_Classic Rock m’w&%‘
. gweRE County Wi e )
L aweR07_Easy Listening

Use Onine Media Lookup ta improve scan resuits

Remove media from the database if the files o longer exist

Update media database f il tags have changed

E=T

Apply

Diector Status: Idie

() Connected

When you add or scan media (Media Scanning Options), you can then view and select the stored/
broadcast media and playlists from the touch screens or on-screen Navigators: TV monitor, touch
screens, MyHome apps, and System Remote Control (in ‘List’ format).

Copyright © 2013 Control4. All Rights Reserved.
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3.1 Directors Dialog

After you start the Control4® Composer ME application, the following dialog appears; you need to use
the controller's network address to connect to the Director.

Directors Dialog:

Directors

Mame Address L Connect
Steph i i
gpeterson-desktop i { Cancel
wirz-test-contraller- 1 e f it il

DranzDeskHCT1O000-0800 8 f i Jrin

home-contraller-100F 00w i il

mattzandHC-1 0000000 sl | f

home-controller-1008 mEE | It f

WSPOA-PROD-182 mmess f i Add...
home-controller-300 mREss i {2t dal

WwhiebDewHC00-000e = s f f

home-controller-5000 mREss

home-controller- 2000 mmEss | f il 3 Fefresh

P ol WOl | WPl | o o o - e

IIT@T

Connecting to a Director on the home network lets you set up your media cover art and metadata on
your controller so it is viewable on the touch screens, MyHome apps, or on-screen Navigators. Each
Director has an associated address.

Director's Dialog buttons:

Connect. Connect to the Director on your controller.
Cancel. Cancel and close the Director dialog.

Add. Launch a dialog that lets you add the Director’s address of the controller to which you
are trying to connect.

Remove. Lets you remove a Director.
Refresh. Update the Director list to display the recently added Directors.

3.2 Media View

Use the Control4® Composer ME Media view to add or scan your media.

Media view (same view as the main screen after startup):

Copyright © 2013 Control4. All Rights Reserved.
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Composer 2.1.0 BX

Ele Meds Help
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) Playlists [ Wetwork Fie: Storage MP3 [Audi] ~ Add
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ideo]
L QweDE Counly MP4 Video] &
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v, gueR10 Rep
I gweRT1_Reggae Updale media database i file tags have changed
45 gweR12_Talk Rado
v TheWho
= Sombion el
() Media

Director Status: Idie

() Connected

There are two (2) types of media that can be added or scanned in a Control4 system:
1. Stored Media
2. Broadcast Media

The other two (2) categories are to scan media and manage playlists.

Note: The AMG lookup service has been switched to Gracenote®. The Sony 777 Disc Changer uses
Gracenote, but the Media Controller cannot access album, title, or artist information from AMG. CDs,
however, can be imported and will show up in the Media database with a date and time stamp.

Other Media Managers: You can use other media managers, for example, iTunes, Windows Media
player, and MediaMonkey to create MP3s or MP4s. You can still use Composer ME to add files to the
Control4 system.

Stored Media
Media types supported:

e CD. Store CD selections and view the Cover Art, Album, Artist, and Genre type (such as
Rock or Country).

e DVD or Disc Changer. Store DVD and CD selections and view the Cover Art, Title, Info,
Results, Media, and Disc List.

e Digital Audio Player. Store MP3, MP4, HDD, AAC, or FLAC music selections and view the
Cover Art, Album, Artist, and Genre type (for example, Rock or Country) on a Home
Controller HC-1000 V3 hard disk or other digital audio player.

o Network File Storage. Store MP3, MP4, HDD, AAC, or FLAC music selections and view the
Cover Art, Album, Artist, and Genre type (for example, Rock or Country) on a hard disk
attached to the network or a USB drive.

Saved: 2/27/2013 10:13:00 AM
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3.2.2 Broadcast Media

Media types supported:
e Direct TV. View Direct TV channel options including Station ID, Genre, and Music Channel.

o Dish Network. View Dish Network channel options including Station ID, Genre, Rating, and
Music Channel.

e Cable TV. View Cable channel options, including Station ID, Genre, Rating, Music, and
Channel.

e UHF/VHF. View UHF channel options including Station ID, Genre, Rating, and HDTV.
e  AM/FM/XM. Scan AM, FM, and XM stations.
e Internet radio. Set up Internet radio stations.

3.3 Menu Options
Composer ME menu options:

¢ File menu. Connect to the Director on your home network, refresh Navigator devices with
new media information, or exit Composer ME.

e Media menu. Create a new playlist, or clear, export, and import media lists. See “Media
Menu” below.

e Help menu. View the Composer ME online help and software version.

3.3.1 File

The File menu lets you perform project file management tasks, connect to Director, start Interviewer,
and refresh Composer ME and the Navigators, including touch screens, MyHome apps (if they are
online), and on-screen Navigators. The file management options relate to the Composer ME project
files you back up on your PC (they have a .c4p extension). Project files always save by default to the
'My Documents' directory.

When you set up a Control4 system, you create live project configuration information on the controller
that is backed up to a project file on your PC. This lists specific information about each system,
including devices, connections, configuration, programming information, and media.

e Connect to Director. Connects you to the Director residing on the controller. When you
connect, project configuration information from the controller is displayed on the Composer
ME screen.

e Disconnect from Director. Disconnects you from the Director. Composer ME prompts you
to back up your project before disconnecting you from the currently-connected Director. This
option is available when connected to the Director.

o Refresh. Refreshes the Composer ME screen with the current information from Director.

o Refresh Navigators. Refreshes the Navigators with the latest information from Director.
Note: MyHome for PCs and tablets must be updated in that app. MyHome for iPhone, iPod
touch, iPad, and Android devices will update if online.

e Exit. Exits Composer. Composer ME prompts you to back up your project prior to exiting the
software and returning to the desktop. Control4 recommends that you always back up your
project before you exit.

Copyright © 2013 Control4. All Rights Reserved.
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Composer 2.1.0

Media Help

Connect to Direckar. ..

Disconneck From Direckor

Refresh FS
Refresh Mavigators Shift+F5

Exit

J.:‘ Seagate FreefigentDezkiop
. LEX<AR MEDIA JUMPDRIVE
Tuner 2
bedia Player
£ Screen Sawver

3.3.2 Media

From the Media menu, the media either has been scanned or manually added to the Media Database.
After an item is added to the media database, the cover art and metadata about the media is viewable
and selectable from any of the Navigators.

Tip: Control4 recommends that you use the Export Media List (see below) feature which lists of all
your media saved to the hard drive on your PC.

The following options are available:

Clear Media List. Clears the media list associated with the highlighted device from the media
database.

Export Media List. Exports a media list for the selected device from your controller to your
PC.

Import Media List. Imports a media list from your PC to your controller.

Export Playlists. Exports a playlist from your controller to your PC.

Import Playlists. Imports a playlist from your PC to your controller.

Import DVD List from File. Imports a Microsoft Excel list of DVD titles for a disc changer.

New Playlist. Creates a playlist of MP3, MP4, AAC, or FLAC files. The playlist is available
from any touch screen or on-screen Navigator. Add albums, remove songs, re-order songs,
etc. Note: If you remove songs from a playlist, it does not remove them from the media
database.

Delete Playlist. Removes a playlist.
Rename Playlist. Renames a playlist.

Tag media files. Used for OS 2.0 conversion of media files so all media players can see the
same tags.

Copyright © 2013 Control4. All Rights Reserved.
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3.3.3 Help

From the Help menu, you can access the online help of this Composer ME User Guide with Index,
Glossary, and Search options, or check the version of your Composer ME software and Director
component.

Setting Up Media and Playlists

Before you can view and select your media from the Control4® Navigators, the Control4 system needs
to be able to recognize it. So you first need to add and scan your media to the controller using the
Composer ME Media view. See “Auto-Scan Media in Composer ME” in this document.

Composer, 2.1.0 (W=
Fle Meda Help
edia " iedi Scarring
hedia Options
7 Stored - Seanting Schedule
= fo, Netwark File Storage @ Mever
£ Audin Media
I, Video Media O ey
L Seagate FreshgentDeskiop © Onthe folloing days:
v #EXAHZMED‘A LUMEDEIE Sunday Monday [ | Tuesday | | Wednesday
uner
Medis Player Thueday | | Fiiday Satuday
(4 Screen Saver
7 Broadoast At
R Siios udio
4 Dish Netuork
Gl e, Files Ta Sean
A Cable Ty Devices: Estensions
7 Playlsts (] Netwark File Storage: MP2 (Budic) | [ Ad
4z gweRi00 Favoies [ seapate FiestgenDeskion | | M [[12“3‘”1]
&, gweR2_Altemalive [ LEXAF MEDIAJUMFDRIVE deoy ez
DV Video)
£, gweR03 Blues [ Turer 2 150 [Video)
15, gweRD4 Classical [ Media Player A Wideo]
L gweRS_Classic Rack WY [Video]
. gweI0E_Couny MPG (vidza)
g o | W MP4 [Video] !
L oweRD7_Easy Listening
15, gweRDE_Intemnational Use Onine Media Lookup ta improve scan resuits
i g:zgf‘g::; Remove meda from the datsbass if the fles no longer exist
I, owoRT1_Rengss Update media database f flle tags have changed
15, gweR12_Talk Rado
. The Wh
() Media
Director Status: |die () Connected

To add and scan songs and albums for playlists, they must be available in MP3, MP4, AAC, or FLAC
format on a PC, controller, or network share. With the MP3, MP4, AAC, or FLAC files you add and

scan, you can create playlists and save them either to the controller’s hard drive or a network storage
drive.

Tip: Composer ME requires that your system is functioning correctly before using your media. For
example, if you have a disc changer that does not appear in the left pane of the Media view, there's
no disc changer in the system to add media to it. Contact your dealer if this is the case.

Prerequisites

Ensure that the appropriate devices have been added and identified to your Control4 system. Your
dealer or installer can do this for you.

To add and scan available digital audio player media:
1. Start Composer ME and connect to Director.
2. Inthe Controller pane, click Add.

Copyright © 2013 Control4. All Rights Reserved.
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Tip: If you get a dialog box that states you cannot add media, make sure your dealer or installer
has identified your controller to the system.

3. Browse to the directory of music files that you want to add or scan.

After the files have been added, the scan automatically starts. In a few moments, the media is
scanned and you will see a list of albums appear. You might see the on-screen Navigator update
during this process also.

Tip: Another way to add files from a network share to a controller is to go to the Windows Start
menu, and select Run. Type //<controller's IP
Address>/media/audio/music/<Artists>/<Albums> and copy the files there.

4. Refresh your Navigators.

5. The media is now selectable for viewing from the touch screens, MyHome apps, on-screen
Navigators, and System Remote Control.

4.1 Setting Up Media on a Controller
When you set up media on a Control4® controller with storage space for media (for example, Home
Controller HC-1000), the controller has a built-in digital audio player. Digital audio is the “cloud” in the
controller that provides the digital audio streaming for music and movies.
Each source device that can provide an audio stream; whether it is a disc changer plugged into the
analog inputs on a Control4 Speaker Point or a controller, it can provide audio to the Digital Audio
servers. Each server must be able to connect to the Digital Audio cloud.
When configuring these connections (your dealer or installer can do this for you), there is always an
open connection to the Digital Audio cloud for each Digital Audio server or Digital Audio client
Consequently, you may see many connections to the Digital Audio cloud depending on the hardware
that is configured in your project.
Prerequisites
Ensure that the appropriate devices have been added and identified to the Control4 system. Your
dealer or installer can do this for you.
Procedure
To add and scan available Digital Audio Player media:
1. Start Composer ME and connect to Director.
2. Inthe Controller pane, click Add.
Tip: If you get a dialog box that states you cannot add media, make sure your dealer or installer
has identified your controller to the system.
3. Browse to the directory of music files that you want to add or scan.
Copyright © 2013 Control4. All Rights Reserved.
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After the files have been added, the scan automatically starts. In a few moments, the media is
scanned and you will see a list of albums appear. You might see the on-screen Navigator update
during this process also.

Tip: Another way to add files from a network share to a controller is to go to the Windows Start
menu, and select Run. Type //<controller's IP
address>/media/audio/music/<Artists>/<Albums> and copy the files there.

4. Refresh your Navigators.

5. The media is now selectable for viewing from the touch screens, on-screen Navigators, and
System Remote Control.

Setting Up Media on a CD or Disc Changer

When setting up a Control4®Disc Changer (or CD changer), you can add and scan media according
to the controls available on your disc changer. Adding and scanning populates the media information
to the media database, which lets you view the media from your touch screens, on-screen Navigators,
MyHome apps, and System Remote Control.

Notes:

1. The AMG c4lookup service from previous releases has been changed to Gracenote®. The Sony
777 Disc Changer uses Gracenote, but the Media Controller can no longer access album, title, or
artist information from AMG (the previous lookup service). CDs, however, can be imported and
will show up in the media database with a date and time stamp.

2. Control4 has not implemented a Ul for browsing CDs stored in a disc changer in OS 2.0 and later.
Use an older navigator (prior to OS 2.0) that supports this functionality if this is important to you.

Other Media Managers: You can use other media managers, for example, iTunes, Windows Media
player, and MediaMonkey to create MP3s or MP4s. You can still use Composer ME and Composer
HE to add files to Control4.

THE SONY 777 DISC CHANGER USES GRACENOTE, BUT THE MEDIA CONTROLLER CAN NO LONGER ACCESS ALBUM, TITLE, OR ARTIST INFORMATION FROM AMG (THE PREVIOUS
LOOKUP SERVICE). CDS, HOWEVER, CAN BE IMPORTED AND WILL SHOW UP IN THE MEDIA DATABASE WITH A DATE AND TIME STAMP.

In the Media pane, if you select CD or Disc Changer, the following options are available. In some
cases, you select an entry and click a button, or just click one of these buttons (Search and Scan):

e Edit. Edit an entry's metadata (Title, Artist, Director, Genre, etc.).
¢ New DVD. Add new DVDs to the media database.

¢ New CD. Add new CDs to the media database.

e Delete. Delete an existing entry.

e Scan. Scan the media on your CD or disc changer to the media database (recommended if
available).

e Search. Search for media titles on your CD or disc changer in the media database.
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The following steps show how to add media to the media database using these options.

Prerequisites

Ensure that the CD or disc changer has been added and identified in the Control4 system. Your
dealer or installer can do this for you.

To scan media on a CD changer to the media database:

1.
2.
3.

Select the CD Changer in the Media pane.
In the Disc Changer pane (right pane), click Scan.

The scan results appear in the Discs pane. After you refresh your Navigators, you are ready to
play music.

To search media on a Disc Changer to add to the media database:

1.
2.

In the Disc Changer pane, click Search. The search dialog appears.

Type the DVD name in the blank box. For example, type 'A Beautiful Mind," and then click
Search. The 'DVD Title' matches appear in the Search Results window.

Use the scrollbar if necessary to find the appropriate DVD title.

Select the DVD title, drag it directly over the empty line item in the disc changer list, and then
select it.

Click Finished.

Repeat the previous steps for the DVDs/CDs in the disc changer that you want to add to the
media database.

Refresh your Navigators. The media you added is now available to view in the Navigators.
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To add and search using the New DVD or New CD options:

1. Select CD or Disc Changer in the Media pane.

2. Select an 'empty' line item for the New DVD and New CD buttons to appear.
3. Click either New DVD or New CD as appropriate.
4

The New Movie or New Album dialog appears. In the Title box, enter the DVD you want to play,
for example: 'A Beautiful Mind.'

5. Click Search.

New DVD:
New Movie ['5__(|
Movie | Cast and Synopsis
Title:
| | [ Search... I
Director Run Time:
| | |
Studio: Released
| || |
Genre: Rating
| | |
Location:
[ |
At
Copyright © 2013 Control4. All Rights Reserved.
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The following results appear:

| [Tite v [ seach |

Search Results

Title: Autist Getre

%

Drama

Drama

Drama

Drama

Drama

Drama

i’ .\ Seabizcuitsd Beautiful Mind [3 Discs) Drama

14

Select an entry to get detailed results:

Search E|
Title Art Cast
|A Beautiful Mind [P%5 Awards Edition] [2 Discs] | Russell Crowe; Jennifer Connelly; Ed Harmis; Paul
Bettany: Adam Goldberg: Judd Hirsch: Josh Lucas;
Director Anthany Fapp: Christopher Plummer: Austin Pendleton:
Jason Gray-Stanford; Vivien Cardone
|Rnn Howard |
Studio:
|DreamWorks |
Genre
|Drama |
Run Time: Released: Rating:
[138 | [em | [Pa13
Synopsis

The true stom of prominent mathematician John Forbes Mash Jr. is the subject of this biographical drama from director Ron Howard, Russell
Crowe stars as the briliant but arrogant and conceited professor Nash. The prof seems guaranteed a rosy future in the early B0s after he
marries beautiful student Alicia [Jennifer Cannelly) and makes a remarkable advancement in the foundations of ''game theam,” which carries
him to the brink of intermational acclaim. Soon after, John is visited by &gent \wWiliam Parcher [Ed Harri], from the ClA, who wants to recruit
him for code-breaking activities. But evidence suggests that Mash's perceptions of reality are cloudy at best; he is struggling to maintain his
tenuous hold on sanity. and &licia suspects a diagnosis of paranoid schizophrenia, B attling decades of ilness with the loval Alicia by his side,
Mash iz ultimately able to gain some control over his mental state, and eventually goes o to tiumphantly win the Nobel Prize. Based loosely
on the book of the same name by Sylvia Nasar, & Beadtiful Mind [2001] co-stars Paul Bettany. Adam Goldberg, Anthony R app. Christopher
Plummer, and Judd Hirsch Karl wiliams, All Movie Guide

[C) 2005 &l Media Guide, LLC
Cantent provided by All Music Guide(R), a trademark of All Media Guide, LLC

<Back | [_Finished | [ Cancel

New CD:
Similar results occur as with the New DVD option. Follow the same steps.
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New Album @

Album | Tracks | Notes
Name:
Artist:
Label: Year:

Genre:

At

Find At File..

6. When the Search dialog appears, use the scrollbar if necessary to find the appropriate cover art,
and highlight it.

You can change the search criteria, and search again if necessary. The possible matches from
the web database appear in the Search Results window (see above).

7. Click Next. You can choose which information to import, and edit any associated information
before adding the media to the media database (see screen above).

8. Click Finished.

9. Click OK.

10. Refresh your Navigators. The DVD is available to view in the CD or DVD pane and on the touch
screens, MyHome apps, and on-screen Navigators.

Note: If no cover art is found in the file’s metadata, then no cover art is associated with the music
unless the system is registered in 4Sight, and you can go to the online media lookup (Media view >
Edit > Name > Search > Select > Next) to obtain the cover art for your music. Check with your dealer
or installer for details.

4.3 Setting Up Videos for a Media Player

Your Control4® dealer or Installer can help you get set up to play videos on your Control4 Media
Player. Your videos must already exist on a network-attached storage drive before they can be
scanned for the Media Player.

For information about scanning files for the Media Player, see the Control4 Media Player User Guide.

4.4  Auto-Scan Media in Composer ME

Copyright © 2013 Control4. All Rights Reserved.
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This section applies to a Sony CX777ES Disc Changer.

The benefits of running a Control4® Disc Changer with bi-directional communications (RS-232), for
example, Sony CX777ES, is that you can scan your DVDs or CDs stored in the disc changer to
identify, index, and automatically apply cover art and media information. You can have your dealer or
installer configure your Control4 system in Composer ME to scan media automatically, or you can set
a manual scan using the Scan button. The default is to scan media manually.

Notes:

1. If you scan a DVD or CD, and the media is not recognized, it will be titled “unknown.” You can edit
the DVD or CD's metadata and manually provide this information from either Composer ME or the
Navigators. If this DVD or CD is then changed to a different slot, the system will apply this same
information.

2. Because media scanning has been moved to the background, the scanning status is only
available through Director status messages. To do this, you can either watch the Director status
line or re-select the media to view the content that has been scanned.

3. Composer ME does not need to be open to scan media. This lets you use other media managers
(iTunes, Windows Media Player, etc.).

Prerequisites

Ensure that the devices you want to scan have been added and identified in the Control4 system.
Your dealer or installer can do this for you.

If you want to schedule regular scans, ensure that your network-attached storage is set up and is
accessible from Composer ME.

To schedule a regular scan of media from a network-attached device for a Media Player, for example:

1. From the Composer ME main screen, select Media Scanning Options. To scan your media now
(and not set up a scheduled scan), click Scan Now and skip the Scanning Schedule in Step 2.

2. Inthe Options pane, set the schedule as follows:
e Scanning Schedule. Select one.
¢ Never. Select if you never want to schedule an automatic scan.
e Every x Days or Weeks (up to 10). Select the frequency to scan.
e On the following days. Select Sunday through Saturday.

e At <time>. Use the up and down arrows to select the time. Highlight AM or PM and type
the value: AM or PM.

e Files To Scan. Select a device and extension.

o Network File Storage. Select if you have a NAS (network attached storage) device you
want to scan.

e USB Drive. The manufacturer's USB drive appears here. Select if you have a USB drive
you want to scan.

e Extensions. Use the up and down arrows to choose the file type to add or remove. To
add a file extension (if it doesn't appear in the list), use the down arrow to select the
extension, select Video or Audio, and then click Add. Click Remove to remove that file
type from the list.
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e Use Online Media Lookup to improve scan results. Check if you don't want the search
to access the Internet for every format lookup, for example, a specific title or cover art.
Tip: Properly tagged files will result in must faster access.

e Remove media from the database if the files no longer exist. Check to remove
database information when a media file has been deleted. Be careful, however, because
if for example you disconnect a USB drive with media on it, the database files will delete
them if checked, and you may not want to delete them if you use the drive again.

e Update media database if file tags have changed. Check to have the database
updated if the metadata changes.
3. Click Apply.

4. Click Scan Now to start the scan immediately or Stop Scan if you've started the scan and want to
stop it.

4.5 Testing the Media Connection
To test control of media through the Control4® Navigators (System Remote Control, on-screen
Navigator, MyHome apps, or touch screens), use the steps outlined in the Control4 System User
Guide.
Suggested test items:
¢ Play an album
e Add an album or track to the Now Playing queue
e Play a playlist created in Composer
e Create a playlist at a Navigator (for example, one of the touch screens)
¢ Play multiple streams of music (play different music in different rooms)
¢ Play a movie on the television, DVD player, or Blu-ray player
4.6 Setting Up Media for Television Stations
Use the Control4® Composer ME Media view to set up a broadcast television station and listings for
display in the Navigators.
Prerequisites
Ensure that your television is added and identified in the Control4 system. Your dealer or installer can
help you do that.
To set up media for broadcast television channels:
1. Highlight UHF/VHF or another broadcast media type.
2. Click Search.
3. When the dialog appears, type your zip code in the box.
4. Click Search, and use the pull-down menu to select Local Broadcast Listings. The available
channels are populated according to the Search Results.
5. Check the boxes to select the desired channels that you want to appear on the touch screens,
MyHome apps, on-screen Navigators, and System Remote Control.
6. Click OK.
Copyright © 2013 Control4. All Rights Reserved.
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Zip: Provider: ‘NTSC[analog]Bmadcast v‘

Search Results

MName Channel # Description Genre Rating Audio Only
WDYRLP 18 False
WDYRLP 22 False
[0 KucLr 2% False
K53GS 46 False
[ 18 False
K52GL 50 False
O K+ 58 False
KUBKLP 2] False
KEBFN 66 False

The selected stations populate in the UHF/VHF pane. You can edit the information as needed;
add a description, genre, etc.

7. (Optional) To edit a channel, select the channel, and click Edit. The following dialog appears.
8. Edit the information and click OK.

_ Composer 2.1.0
Fle Media Help

[ [

Weda e

&Lz, Rosio Streamer UPHP- || At Channel# | Name Desciption Genre
f, Audio Media 18 WDYRLP
e Viden Media o KucLLp
£, DIRECTYZPC Media Server 5 YEXL
Audio Media
£ Video Media f 5 KUERLP
& {5 DIRECTYZPT Media Server
& Audio Media
L2, Video Media
=-f, Rhapsod [acooperP2)
f, Audio Media
e Viden Media
& i, DIRECTYZPC Media Server
£ Audio Media
Video Media
& {5 DIRECTYZPT Media Server
& Audio Media
L2, Video Media
= f£ CHEREE-PL: Cheree:
Audio Media
Viden Media Genre: Rating
1, JEFFSANDBERFSGE: Adftinistrator ‘ ] |
£ Audio Media
Jt, Video Media
=g I0J04M: jojer
Audio Media

WDYRLP 3

Broadeast |

Name:
[wovRLP |

Description:

Channel:
[1e | O Audio Oniy

A

Find At File.

L2, Video Media
A& Screen Saver
|4 Broadeast

4 AM Radio
B 1 Radio
4 FM Radio
4l Dish Network,
" UHFAVHE
# Cable TV
(&' Intemet Radio

L Playists v
@ Media

Paste From Clipboard

Director Status: Ide () Connected

9. Refresh your Navigators. The media can now be selected to view in the Navigators.
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4.7 Setting Up Media for Radio Stations

Use the Control4® Composer ME Media view to set up radio station listings to display on the
Navigators.

Prerequisites

1. Ensure that your devices are added and identified in the Control4 system. Your dealer or installer
can do that for you.

2. Ensure that you have a tuner in the system.

To set up media for radio stations:

1. Under Broadcast, select the radio type: AM Radio, FM Radio, or XM Radio.
2. Click Search.

3. When the dialog appears, type your zip code in the box.

4

Click Search again. Use the pull-down menu to select AM Broadcast Stations or FM Broadcast
Stations if applicable. The available stations are populated in the Search Results window.

5. Check the boxes to select the desired stations that you want to appear on the touch screens, on-
screen Navigators, MyHome apps, and System Remote Control for that radio type.

6. Click OK.
s x|
Zip: | 84020 Provider | &M Broadcast Stations v
Search Results
Hame Channel # Description Genre FRating Audio Only L
KaLL 700 Ak Morth Salt Lake City, UT Sports True
O EANN 1120 &M Rop. UT Chiistian Conte... Tiue
Fl KBJA 1640 &M Sandy, UT Spanish True
KCPw/ 1010 AM Tocele, UT Public Radia True
KDVL 10E0 A4 South Salk Lake, UT Nostalgia Tue
O KETY 1450 Ak Provo, UT Religious Tiue
KFHZ 1320 &M Salt Lake City, UT Sports True
.| KHON 1480 &AM Spanish Fork, UT Religious True
KIas 1230 &M Murray, UT Sports True
O KEAT BE0 AM Salt Lake City, UT Country True
O KLLE 1510 &M WestJordan, UT Gospel Music True
.| KLO 1430 &AM Ogden, UT Talk True
O kMRl TEE0 AM ‘whest Walley City, UT Religious Tue
O EMTI E50 &M Manti, UT Country True
O khak 540 A1 Delta, UT Talk True
[1  ENRS 570 AM Salt Lake City, UT Talk. True
O koaL 750 Ak Price, UT Sports True
0 kovo 960 AM Pravo, UT Sparts True
[l KRRD TEO0 AM Centerville, UT Spanish True ¥

The selected stations display in the AM or FM Radio pane.
7. (Optional) To edit a station, select the station, and then click Edit.
8. Edit the information, and then click OK.
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& BEE]

File Meda Help

Meda Charels
=1 f£ Rosio StreamerUFNF-AY A|[ At | Channel# | Name Desciption Genre ~
&, pudio Media BIFM  KWECR Ogden, UT Top40
4, Video Media BIFM KCPW Salt Lake Cit, UT Public Fadio
=) DIRECTVZPC Media Server BIFM KCPW Salt Lake City, UT Public Fadia
i Cf‘” me:\a T omIRM ke Provo, UT Classical
. Video Media )
o i DRECTVIP My Sarvr :g ; m E:EE Skt Lake City, UT Public Radio
£ Audio Media
£ Video Media Elkiz] S T
SN —— IFM KPCw Broadoast
£ Audio Media I3 KPCW
&, Video Media Eralimd s L Name:
= fF} DIRECTV2PE Media Server WIMM KUBL KEPw
£ Audio Media S41FM  KODJ
. Video Media S41FM KODJ Description:
= 4 DIRECTV2PC Media Server 949FM  KHTE Salt Lake City, UT
f Audio Media WHEFM KYFD
I, Video Media %I KRK Channet:
= 4} CHEREE-PC: Cheree, WARM KZHT 88.3FM [¥] Audio Only
& Audio Media WIFM  KBZN
I Video Media e R Genre: Rating:
a4 iiF;SJ:ND;EdRFSBE Adrinistrator FER] o Public Rado
v Audio Meda
£ Ve W) m
= 4} JDIDAM: oo
£ Audio Media 935 FM KMy Find At File. v
I Video Media —
(' Screen Saver L
=1 fi} Rhapsody [dmebfde-PC)
‘I‘L oo Med. Channel: 88.3 F
L, Video Me No Name: KCPW
77 Broadcast o
v A Radio :’“‘_"I"’;:‘ Description: Salf
B >4 Radio vailable s
4 FM Radio
43 Dish Network
UHF /MHE
—
) Media
Director Status: Idle () Connected

9. Refresh your Navigators.

10. Repeat Steps 1-5 for each radio broadcast (AM, FM, XM) you want to set up. Set up each one
separately. The media is now ready to view in the Navigators for selection.

4.8 Setting Up Internet Radio

Note: Internet radio supports ONLY MP3 and MP4 streaming radio stations.

Use the Control4® Composer Media view to add, view and select Internet radio stations that you can
play from touch screens, MyHome apps, or on-screen Navigators.

Prerequisites
1. Ensure that the controller is installed and identified as directed in the controller's installation guide.

2. Ensure that the Internet radio stations you add are in MP3 or MP4 format. You'll need to create a
new form for each station you add.

To configure Internet radio:

1. Start Composer and connect to a Director.
2. Click the Media view.

3. From the Media list, click Internet Radio.
4. Inthe Internet Radio pane, click New.
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5. Fill out the form:
a. Name: Add the name of the station.
b. Description: Add a description that's meaningful.

c. Channel: Add the URL for the channel. Note: Locate the URL of the MP3 or MP4 stream that
starts with http://...

Genre: Add a genre if appropriate.
e. Check Audio Only for listening.

f.  Cover Art: If you'd like, you can copy the radio station art to your list. In a browser, go to the
link and click Images. Click Find Art File to locate an image, copy it to your clipboard and
then click Paste from Clipboard.

g. Click OK.
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6. Go to the touch screen, MyHome apps, or on-screen Navigator and select the Listen > Station.
Note: If you have several sources, Internet Radio appears under Sources.

4.9 Using External Storage Devices

Access digital music from an external storage device attached to your Control4® system. External
storage devices include USB flash drives, USB external hard drives, or a PC’s hard drive on the home

network. Set up your music according to the external storage device and networked file storage as
described here.

Note: When you remove the external drive (network, USB, etc.), the music is no longer available. To
access the music again, attach the external storage device, and then refresh your Navigators.

Prerequisites
External storage devices must have media stored in unprotected MP3, MP4, AAC, or FLAC formats.

To attach and scan external storage devices using a USB connection:
1. Power on the external storage device.

2. The documentation for your controller shows you how to attach the external hard drive to the USB
port. Check with your dealer for details or to get a copy.

3. After connecting the external storage device, scan the music on the external device connected to
the controller to make it available on the Control4 system. Highlight the controller to which the
external device is connected.

4. Click the Media view.
In the view, select the external storage device.
6. Click Scan. When scanning, the media appears as it is located on the controller.

o
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Note: You can add media from the external storage device when connected to the controller,
however, Control4 recommends that you connect your external drive directly to the PC where you
want to copy media, and then attach it to the controller for scanning.

To access and scan the network-shared storage devices:
1. Check with your dealer to create a shared network drive.

Example: Using Windows XP to make a local C:/ Drive directory available on the network, right-
click the folder and select Sharing and Security. Click Share this folder.

2. Configure the username, password, and workgroup (or domain) for the network file share. This
information varies between types; contact your dealer or installer if you need help with this
information.

3. Highlight the Network File Storage object.
4. Click Add or Scan.

Setting Up Playlists
Use the Control4® Composer ME Media view to set up a playlist to play songs and albums from your
touch screens, MyHome apps, on-screen Navigators, and System Remote Control.

Prerequisites

Ensure that the appropriate audio devices are added and identified on the Control4 system. Ensure
that you have scanned your media in the Digital Audio player. Your dealer or installer can help you do
this.

Playlists are designed exclusively for streaming media in Digital Audio. If you subscribe to the
Rhapsody® music service or another service, then Rhapsody playlists can be created using a
Navigator. Check the website for your music service or the music service’s Technical Support for
details. In OS 2.0 and later, playlists can include CDs/DVDs, broadcast channels or stations, or
Internet stations, but they are in a separate playlist from those in Rhapsody or your preferred music
service.

Note: To set up a Rhapsody subscription, create a Rhapsody account at
http://www.control4.com/rhapsody, and then refer to the information found in the Control4 System
User Guide.
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To create a playlist:
1. From the Media menu, select New Playlist.

2. A'New playlist appears. You can rename it now, or later you can right-click and select Rename
Playlist to change the name. Example: Change New to Frank’s Playlist.

3. Drag the list of songs to the playlist.

4. (Optional) Have your dealer or installer add any albums or songs you want to the playlist. See
Control4 System User Guide for details.

5. Create, edit and play songs from your playlists using your touch screens, MyHome apps, or on-
screen Navigators.

To delete albums or songs from the playlist:
1. After you add the albums, select the playlist that contains the songs to delete.
2. Right-click on the songs you don't want in your playlist, and select Delete.

Tip: To remove multiple songs, press Shift, select the songs, and then right-click Delete.

4.11 Editing Media Information
Use the Control4® Composer ME Media view to edit CD or DVD media information. You can edit
media information also on the touch screens, MyHome apps, or on-screen Navigators.
Prerequisites
Ensure that the appropriate media devices have been added and identified to the Control4 system.
Your dealer or installer can help you do this.
To edit CD information:
1. Inthe Media view, double-click the device on which you want to edit a CD, for example, a CD
changer, disc changer, controller, or digital audio.
2. Click the Edit button, or double-click the media under <Media> Title.
3. To edit and enter any changes, click the Album tab (for music), for example. Edit the information
in the boxes under Name, Artist, Label, or Genre.
e Click the Tracks and Notes tabs to view and edit Track Titles and Notes.
e Click Find Art File or Remove Art to change the cover art.
4. When you are finished, click OK.
5. Click one of the Search buttons next to the Name to search the database for similar entries.
6. To select a search result, select the album Title and double-click, or click Next.
7. Atthe next screen, view and edit the album information, including Name, Artist/Composer, Label,
Genre, Year, Art, and Notes.
8. Make your changes, and click Finished. To return to the previous screens, click Back.
To edit DVD information:
1. Inthe Media view, select the disc changer or DVD, and then select a movie.
2. Click the Edit button, or double-click the title under Discs.
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3. Click the Movie tab. Edit the Title, Director, Studio, Genre, Run Time, Release date, and Rating
as desired.

4. Click the Cast and Synopsis tab. Click in the Cast and Synopsis boxes to make the desired
changes.

5. Click the Movie tab.
6. Click Search to search the database for other DVDs.

7. Double-click the desired DVD, and edit the information as desired according to the previous
steps.

8. When you are finished, click Finished.

Other Composer ME Tasks

Use the Control4® Composer ME to perform other media-related tasks (see the sections below).
e “Clearing a Media List”
e “Exporting a Media List”
¢ ‘“Importing a Media List”
e “Updating Composer ME”

5.1 Clearing a Media List
Use the Control4® Composer ME Media menu to clean out information (metadata) about aloums and
songs.
Prerequisites
Ensure that media has been added and identified to the Control4 system. Your dealer or installer can
help you do that.
To clear a media list:
1. Select the device on which you want to clear the media information. Example: Digital Audio.
2. From the Media menu, select Clear Media List. This removes the information including the title,

cover art, and related information from the media database.

Note: This option does not remove the media files.

5.2 Exporting a Media List
Use the Control4® Composer ME Media menu to export a media list from your media database to
your PC.
Prerequisites
Ensure that the device to export to and the media have been added and identified in the Control4
system. Your dealer or installer can help you do that.
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To export the media list:
1. Select the device on which you want to export the media list. Example: Digital Audio.
2. From the Media menu, select Export Media List.

This saves a copy of the file that contains all the title art and information from the media database to
your PC.

IMPORTANT: This option moves the media files.

5.3 Importing a Media List

Use the Control4® Composer ME Media menu to import a media list from your PC to your controller’s
media database.

Prerequisites

Ensure that the device to export to and the media have been added and identified to the Control4
system. Your dealer or installer can help you with that.

To import the media list from your PC to the Media Database:
1. Select the device on which you want to import the media list. Example: Digital Audio.
2. From the Media menu, select Import Media List.

This saves a copy of the file that contains all the title art and information from your PC to your
controller's media database.

IMPORTANT! This option does not move the media files.

5.4 Updating Composer ME

Use Control4® Composer ME to update the software to a new version.

You can update three (3) ways:
1. Help menu

2. Windows Start menu

3. Runthe Composer ME install

Prerequisites
Ensure that Composer ME has been installed on your PC.
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To update Composer ME:
1. Update according to these options.
e From the Help menu, select Check for Updates.

e From the Windows Start menu, select Start > All Programs > Control4 > Composer >
Update Composer.

e Run the installation.
2. Follow the on-screen instructions to complete the update.
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6. Glossary

4

4Sight: An Internet service that provides a connection to the home automation system any time and
from any place worldwide.

A

AAC: Advanced Audio Coding. A successor to the MP3 format. A standard, lossy compression and
encoding scheme for digital audio. Touts better sound quality.

AV: Audio Video

C
CD: (Compact Disc) - An optical disc that stores digital data. This format is compatible with Control4
products.
Composer: The Control4 software used to design and define a Control4 home automation system.
Composer Pro: Composer is used to set up and configure Control4 devices to communicate with
each other in a home automation system.

connection: Binding or linking devices together in Composer so they can communicate with each
other.

contact: Contacts are generally used to monitor the status of something (door, window, water sensor,
etc.) and can be hooked up through a security panel or directly using a Control4 controller or
Contact/Relay Extender. Contacts connected to a Control4 controller or Contact/Relay Extender can
be configured either as NC (normally closed) or NO (normally open).

Control4 system: A home automation system designed and developed by Control4.

controller: The main device that makes home automation possible. There may be multiple controllers
within a Control4 system. The controller that runs Director is referred to as the Primary controller.

D

device: A component that requires a device driver; code that is used to allow the Control4 system to
work with that device.

device driver: Every device in the Control4 system needs a corresponding device driver to control
the device.

digital audio player: Provides digital audio streaming capabilities from a controller with hard disk
space for music and movies.

Director: Each Control4 controller (such as a Home Controller HC-500) ships with pre-installed
Director software (Linux based) embedded in the device. The Director communicates with Control4
products and third-party products to enable home automation and interaction of individual devices.
Director runs the Control4 devices. Composer Pro is the software used to connect to and program a
system Director that resides on a controller.

DVD: (Digital Versatile Disc) — A media format for video and data storage.
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E

Ethernet: Uses Ethernet category 5 (CAT5 or CAT5e) wiring to transfer data. Ethernet uses a star
network topology that allows multiple points to communicate to a single point. The Speaker Point®
devices and touch screens use Ethernet to communicate to the Control4 controller.

F

file format: A format used by applications to store/read files.

FLAC: Supported by Control4 for software release 1.8, this is a free, open source, lossless audio
codec format that supports tagging, cover art and fast seeking. Audio is compressed with no loss in
quality.

H

home network: A network installed in the customer’s home that provides an Ethernet or wireless
connection so that Control4 devices can communicate with each other.

home automation system: The Control4 system: a line of home automation products that
communicate with each other over Ethernet, WiFi, or ZigBee for a total home automation experience.

L
LCD: (Liquid Crystal Display) - A display used with some Control4 interfaces.
LCD Navigator: An LCD device used to control lighting, music, videos, etc., on an LCD screen.
List Navigator: A System Remote Control device uses a Navigator that lists the options.

M

media database: Media information is stored in the media database, which will permit users to view
the media from the Navigators.

metadata: The information that describes the media: title, cover art, artist, song or movie, genre, etc.
MP3: A music format that makes streaming audio available.
MP4: An audio and video format. Can also store images and subtitles.

N

Navigator: A Control4 Navigator used with the Control4 system to control lights, music, videos, etc.
Navigator is software that the customer interacts with using a universal remote control, On-Screen
Navigator, MyHome apps, or touch screen.

network-attached storage (NAS): A hard drive or network share drive that can be attached to the
Control4 system and used to retrieve and play music and movies in the system.

O

On-Screen Device: Allows you to select the controller (Media Controller or Home Theater Controller)
in the room that controls the source for the on-screen display.

P

playlist: A list of songs compiled in a list. The list can be compiled by songwriter, album, song type, or
any combination.
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programming: A machine-readable artificial language used to express computations that can be
performed by a device.

project tree: A tree view in Composer where the project is layered by the larger branches (Home,
Office, etc.) and then the lower branches (floor, rooms, etc.), and finally to the leaf level (drivers).

R
Remote Director: Connects you to the home network while working in Composer from a remote
location.

S

scan: An electronic read of media for replay on Control4 devices.

switch: An extension of a router that adds more Ethernet ports to support additional devices or clients
on the local network.

System Remote Control: A Control4 System Remote Control is a universal solution that replaces
remote control devices from other manufacturers, and includes programmable buttons. This System
Remote Control can access on-screen (graphical) Navigators.

T

touch screen: A touch screen is a home automation system Navigator that controls the home’s
lighting, music, videos, and other devices on the home automation system.

U
USB: (Universal Serial Bus) - A format used with USB sticks that plug in to a USB port on Control4
devices.

\

virtual connection: A term used in Composer Pro to indicate a connection outside the network.

Virtual Director: A connection to a virtual controller only (a PC is the Director host rather than the
controller). Projects created or edited here are benign until the saved project is loaded onto a
controller.

w

WiFi: Uses bi-directional wireless technology to transfer data. WiFi (wireless fidelity) devices
“connect” to each other by transmitting and receiving signals on a specific frequency of the radio band
using a wireless access point. This technology uses the star network topology. WiFi uses high
bandwidth 802.11.

WMA: (Windows Media Audio) — Audio data compression technology developed at Microsoft; an
audio file format that competes with MP3.

Z

ZigBee: A wireless network that uses bi-directional wireless mesh network technology to transfer
messages from one device to another. Unlike a star network topology where devices can only send
messages to each other by sending them first to a single central device (which then delivers the
message to the recipient device), a mesh network topology allows the devices to forward messages
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from one device to another, thereby extending the effective range of the network. Uses low bandwidth
802.15.4. 250 devices are allowed per controller but Control4 recommends 125.

ZigBee Pro: The 1.1 version of ZigBee that provides improvements in standardization by: allowing

more interoperability with other Control4 devices, support for home automation profiles, and improving
the scalability of multiple ZigBee access points.
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7. Index
AAC, 10 Edit metadata, 17
Add Director, 11 Exit Composer, 9, 13
Add new CD, 19 Export media list, 14
Add new DVD, 19 Export playlists, 14
Album tab, 30 File extension, add, 22
AM radio, add, 25 File menu, 13
AM/FM/XM, 13 File tags, 14
AMG lookup, 12 Find cover art, 30
Broadcast media, scan, 12 FLAC, 10
Broadcast television selection, 23 FM radio stations, add, 25
Cable TV, 13 GNU, 2
CD, 12 Gracenote, 2
add new, 17, 20 Gracenote lookup service, 12
edit information, 30 Hard disk requirements, 7
CD changer HDD, 12
scan media, 18 Help menu, 13
set up media, 17 Import DVD list from file, 14
clear media list, 14 Import media list, 14
Composer Import playlists, 14
close, 9 Installation, 7
refresh Navigators, 9 Internet radio, setup, 13
Composer ME Legal notice, 2
get started, 6 Local broadcast listings, 23
interface, 8 Media Auto-Scan, 22
update, 32 Media controller limitations, 12
Connect to Director, 11, 13 Media database, 12
Contact information, 2 media database, scanning and adding to, 17
Copyright, 2 Media file tags, 14
Cover art, find, 30 Media list, clear, 31
Cover art, not found, 21 Media list, export, 31
Create playlist, 30 Media list, import, 32
Delete media, 17 Media menu, 13
Delete playlist, 14 Media pane, 17
Delete songs from playlist, 30 Media player, 21
Digital audio, 12 and NAS, 21
Digital audio player, 29 Media Player
Direct TV, 13 scanning files, 21
Directors dialog, 11 Media scanning, status messages, 22
Disc changer, 12 Media view, 11
Disc Changer pane, 18 Media, remove, 23
disc changer, set up media, 17 Memory requirements, 7
Disclaimer, 2 Menu options, 13
Disconnect from Director, 13 Movie tab, 31
Discs pane, 18 Movie, add new, 19
Dish Network, 13 MP3, 10
DVD, 12 MPEG, 2
add new, 17 Music, add new, 20
edit information, 30 Network file storage, 12
DVD, add new, 19 Network requirements, 6
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Windows Media Player, 22

Search dialog, 21
Search Results window, 21
Software requirements, 6

Processor requirements, 7 Sony disc changer, auto-scan, 22

Purpose of document, 5 Start Composer ME, 7
Radio stations, add, 25 stop scan, 23
Refresh Composer ME, 9 Stored media, scan, 12
Refresh Director list, 11 Test media, 23
Refresh Navigators, 13 UHF/VHF, 13, 23
Refresh screen, 13 UHF/VHF pane, 24
Related documents, 5 Unprotected format, media storage devices, 28
Remove media, 23 USB drive
Rename playlist, 14 scan, 22
Requirements, 6 using, 28
Rhapsody, 29 USB port, 28
Scan media, 11, 17 Video requirements, 7
Scan now, 23 What's new, 6
Scanning Windows 7, 7

iTunes, 22 Windows Vista, 7

Schedule, 22 Windows XP, 7

USB drive, 22 WMA, 10
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